UTC - Software Evolution Softwar e Technology Research Laboratory
http://www.cse.dmu.ac.uk/STRL/

FermaT Maintenance Environment
Tutorial

Document type Tutorial

Author Matthias Ladkau
Date April 22, 2007
Version 0.1

Inspected Prof. Hussein Zedan
Comments
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Abstract

This document gives a brief practical oriented introductio the FermaT Mainte-
nance Environment (FME). It covers the installation andyesaf the program via
practical examples.
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1 Installation of the FermaT Maintenance Environment

This chapter gives a guidance through the installationgs®of the FermaT Main-
tenance Environment. It explains the installation on Urixix and Windows op-
erating systems.

1.1 Installation on Unix / Linux

1.1.1 Requirements

e Perl (version >=5.6.1)
http://www.cpan.org/

e Bit::Vector (A perl module for efficient sets of integers biefien Beyer)
http://search.cpan.org/search?module=Bit::Vector

e Set::IntRange (Perl module based on Bit::Vector for setintgfgers in a
given range by Steffen Beyer)
http://search.cpan.org/search?module=Set::IntRange

e gcc or a compatible C compiler
http://www.gnu.org/software/gcc/gcc.html

e A working JAVA 6.0 environment
http://java.sun.com/

e The “make” command
http://java.sun.com/

1.1.2 Install of Perl and gcc

Perl and gcc are included in every current linux distributicSee the install in-
structions of your distributions if these components areafr@ady installed in the
standard installation.

1.1.3 Installation of a JAVA 6.0 environment

On order for the FME to work correctly the Java environmenS0iN should be
used. The environment can directly optained from the SUNrbsigstems as a
cost-free download.

e Download the Java JDK 6 for Unix/Linux from
http://java.sun.com/javase/downloads/index.jsp
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e Install it according to the provided instructions

1.1.4 Installation of Bit::Vector for perl
e Unpack the archive:

tar zxvf Bit-Vector-6.4.tar.gz

e Change directory to the unpacked files:

cd Bit-Vector-6.4

e Make and install the binaries:
perl Makefile.PL

make
make install

1.15 Installation of Set-IntRange for perl
e Unpack the archive:

tar zxvf Set-IntRange-5.1.tar

e Change directory to the unpacked files:

cd Set-IntRange-5.1

e Make and install the binaries:
perl Makefile.PL

make
make install

1.1.6 Installation of FermaT Maintenance Environment

e Unpack the archive (note the directory path must not corgajnspace char-
acters) :



tar zxvf fre.tar.gz

e Change directory to the unpacked files:

cd fne

e The program should run now by executing time. sh script

1.2 Installation on Windows

121 Requirements

e Active Perl (version >=5.6)
http://www.activestate.com/ActivePerl/

e Bit::Vector (A perl module for efficient sets of integers biefien Beyer)
http://search.cpan.org/search?module=Bit::Vector

e Set::IntRange (Perl module based on Bit::Vector for setintegers in a
given range by Steffen Beyer)
http://search.cpan.org/search?module=Set::IntRange

e MinGW package
http://ww.mingw.org/

e Windows Installer >2.0 (if using older versions of windowg.eNin9x/WinME)
http://downloads.activestate.com/contrib/Micro9df#2.0/

e A working JAVA 6.0 environment
http://java.sun.com/

1.2.2 Install Windows Installer (for older versions of windows)

Install InstMsiA.exe when using Win9x/WinME or InstMsiVWMefor WinNT.

1.2.3 Installation of a JAVA 6.0 environment

The Java environment which is shipped with Windows is insigfit. Java should
be directly optained from the vendor SUN Microsystems.


http://www.activestate.com/ActivePerl/
http://search.cpan.org/search?module=Bit::Vector
http://search.cpan.org/search?module=Set::IntRange
http://www.mingw.org/
http://downloads.activestate.com/contrib/Microsoft/MSI2.0/
http://java.sun.com/

e Download the Java JDK 6 for Windows from
http://java.sun.com/javase/downloads/index.jsp

e Install it according to the provided instructions

1.2.4 Install active perl

Install ActivePerl-5.8.8.817-MSWin32-x86-257965.msi.

The command "perl" should now work in a DOS box (Start->Remd). To end
perl press CTRL+C.

1.25 Install of Bit::Vector and Set-IntRange for perl

This step requires an internet connection. Open a DOS boxusmitppm". At the
prompt, type:

ppm install Bit-Vector
ppm install Set-IntRange

ppm quit

If this doesn’t work then the names might have changed. Tetrch the "Set"
and Bit" modules to get the right name:

ppm search Bit

or
ppm search Set

1.2.6 Install gcc

e Install the MinGW (e.g. MinGW-6.0.2.exe)

e Extent the path variable for the gcc compiler
Start->Settings->Control Panel->System
Pick Advanced tab
Click on "Environment Variables"
Search for "Path" variable in the system variables list

Click on edit


http://java.sun.com/javase/downloads/index.jsp

Append to the Variable value string the path of the gcc.exe

(e.g. when MinGW was installed te&!'\ Program Fi | es\ M nGW then ap-
pend 'C:\ Program Fi | es\M nGAl bi n")

e The command "gcc" should now work in a DOS box

1.2.7 Installation of FermaT Maintenance Environment

e Unpack the archive (with WinZIP or WinRAR) into any diregtqinote the
directory path must not contain any space characters)

e The program should run now by executing the. bat script

2 Applied Software Evolution With The FermaT toolset

2.1 FermaT Transformation System

The objective of the FermaT transformation system is to kentd® migration of
large, highly complex legacy systems from Assembler to drigével language
such as C or COBOL. The FermaT transformation system is tmithe transfor-
mation theory that has the following objectives.

. Improving the maintainability (in particular, flexitijfi and reliability, and
. hence extending the lifetime) of existing mission-catisoftware systems;
Translating programs to modern programming languages;

Developing and maintaining safety-critical applicatp

I N

Extracting reusable components from current systenmsintg their spec-
ifications, and storing the specification, implementatiang development
strategy in a repository for subsequent reuse;

6. Reverse engineering from existing systems to high-lspetifications, fol-
lowed by subsequent reengineering and evolutionary dpxedat;

Once migrated, these systems are substantially easieritdainaand can evolve
faster to meet the changing needs of the business they supjmike simple line

by line language migration technologies, the FermaT tansition’s unique se-
mantics preserving code transformations enable the atligipplication to be auto-
matically cleaned-up, simplified and restructured to itsmpm state for migration



to the chosen new languag.[ This ensures that only functional code is migrated
to the new language, helping to ensure that the migratedisaignificantly easier
to maintain and adapt than the original.

Because of FermaT’s use of a unique and formally defined leigdl-language,

Wide Spectrum Language (WSL), and its specifically desigrmte transforma-

tions, the migration process can be automa@d The migration process of the
FermaT transformation system can be divided into threeclssps:

1. Translation of the assembler to WSL;
2. Translate and restructure data declarations;
3. Apply semantics-preserving WSL to WSL transformations;

4. Translate the high-level WSL to the target language.

2.2 TheWide-Spectrum Language

The core of the FermaT transformation system is the WSL laggu It is based
on a wide spectrum language, using Morgan’s specificatiaterstent 2] and Di-
jkstra's guarded commands][ The intention is to form a language which acts as
an intermediate language when processing a legacy sy8iem [

WSL was designed for reengineering tasks and covers:

Simple, regular and formally defined semantics

Simple, clear and unambiguous syntax

A wide range of transformations with simple, mechanicaleckable cor-
rectness conditions

The ability to express low-level programs and high-levedtedzt specifica-
tions

The heart of the WSL language is a very small and mathemigticattable ker-

nel language. This language supports already all necesparations needed for
a programming and specification language. In the contextisftiny kernel lan-

guage it is relatively easy to prove the correctness of sstoamation, but the

language is not very expressive for programming. For thregor the language is
extended into an expressive programming language by dgfiréw constructs in
terms of the kernel. This extension is carried out in a sesfdayers with each

layer building on the previous language level (s8f¢r details).



2.3 FermaT Maintenance Environment

The FME is written entirely in the Java language. The chaicetfe Java language
was made because it is a very safe (strong typed) and flexdbfubge with an

extensive API and a vast amount of open-source librariealfoost every possible
computer task. When the program starts the following windbeauld appear:

!FermaT Maintenance Environment = ig _5]

File Edit Analyse ‘Window Help

B8 abstract syntasTamienhe] B3| (9 wsi =10l

View Edit  Wiew

B =T

Transformation

bk | @& |® g;|

e T0: Abort_Processing -
T1: Absorb Left j
T2: Absorb Right

T3: Actions ko Where

T4: Add Assertion

TS: Add Left

T6: Align Mested Statements

T7: Apply To Right

78: Collapse Action System

T9: Callapse All Action Systems

T10: Combine Where Structures

T11: Constant Propagation

T12: D Do To Floop

T13: Delete All Assertions

T14: Delete All Comments

T15: Delete All Redundant

T16: Delete all Skips

T17: Delete Ttem

T18: Delete Redundant Registers -

4] | »
B Conso =|0l x|

Figure 1: The FermaT Maintenance Environment

Primary the FME is a graphical interface to the FermaT ti@msétion engine. It
consists of a text editor which is able to express WSL togetith an Abstract
Syntax Tree (AST) viewer. A maintainer can navigate throtlgh code via the
source code or via the AST. The environment provides a certsothe FermaT
transformation engine which can be used to directly comntla@e@ngine.

The core of the transformation engine is a set of mathenmgticaven program

transformation to simplify the source code. The transfdiona can be selected
from a transformation catalogue and performed on a chunk 8t \tbde. The

transformations will either produce a semantically egeivtor refined version of
the source program construdj.
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Transformation
Catalogue

B rermal Maintenance Environment - Ctipro'javaleclipse_warkspace\f iolx]
Fie Edt Andlyse Window Help
B =100 x| -] T [ _lolx
Wiew Edit  View Transformation
kaJ TP x = 0 THEN y := 1 @@@'
coopees —| [ELSTF »-1 THEN PRINT('Hello Worla')
- el | |ELSIF FALSE THEN PRINT(*Goodby cruel world') T0: abort_Processing P
= ELSE y := 2 FI; TL: Absorb Left
= (3 Guarded
Abstract Syntax 1 Ua’E;ua‘ DO DO i:=1 0D 0D T2 Absorb Right
Tree T & variable () IT3: Aictions to Where
# Humber (1) T4: Aidd Assertion
163 Satents 5! dd Left
poa i O 6 Align Nested Statements
o e 71 fipply To Right
g 78: Colapse Action System
& Numb 791 Collapse All Action Systems
® 2y Guarded o TL0: Cornbine Where Structures
-3 Guded TL1: Constant Fropagation
5 o Gusdnd T12: B Do To Floop
WSL Editor T e T 713! Delete Al nssertions
S Statemert TL4: Delete All Comments
=} . A's"sinnmgnt T15: Delete All Redundant
O i L6 Delete Al Skips
i TL7: Delete Ttem
® fumbe T18: Delete Redundart Registers +
=) Floop Caret Position=55 ‘ .[‘J
-y _io
= ) Floop L . 23
= ) Statements
= Assignmen
= hssign_]
®va_
g i
Tree Row=12 [T

Console to
migration engine

Figure 2: Components of the FermaT Maintenance Environment

The communication between the FermaT Maintenance Envieohiand the Fer-
maT transformation engine is provided through a commuicicgtipe provided by
the underlying operation system.

FermaT
Maintenance
Environment

Communication
Pipe

FermaT

Transformation

Engine

Figure 3: Communication between the Engine and the FME
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3 Getting Started

3.1 First experience

The followings are two examples written in WSL. First ExampHello world in
WSL

PRINT("Hel I 0 World™")

The output should look something like this when it is dirgakecuted with the
“wsl.pl” script of the engine:

Witing: C\DOKUME~1\TheUser\ LOKALE~1\ Tenp\t 11436. scm
Starting Execution...

Hell o Worl d!

Execution time: O

To get this result in the FME we can type the statement fronvaliato the edi-
tor. We can now save the file by selecting “Fite”Save as WSL File”. Note that
the Abstract Syntax Tree in the FME is only updated after tleehfis been saved.
When we now select “File>"Run WSL File” the following window should ap-
pear:

4 aintenance Envir =13l x|
File Edt Analyse Window Help
A =101 x||[- FEETn 4 =10l [-f =1alx
View Edit Yiew Transformation
E |I; I PRINT ("Hello World') @l@]@‘
g Stat:"';"“ T0: Abart,_Processing
- T Absorb Left
B Cprotjavatedlipse_workspace’ fme'disthtest.ams] 1ol x|
Uriting: C:)DOKUME~1}ml\LOKALE~1)Temp)t12076.5cm
Starting Execution...
Hello World
Exscution time: O
s
»
0l x|

Figure 4: Execution of Hello World

The first line tells the interested reader that a temporagytfll1436.scm” has been
written to the temporary directory of the current user (heneer the windows
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operating system). This is because the FermaT transfamatigine converts a
WSL program before execution into Scheme. The Scheme naterps than used
to execute the program. This technigue has a serious dr&wbhe runtime errors
detected be Scheme will refer to lines in the Scheme prograSurthe user isn't
able to trace the error according to line numbers unless berkmexactly which

WSL statement of his program is mapped to particular Scheatensent(s) in the
executed program. For development language this would baaus problem but
as mentioned before the WSL language is intended to be amietiate language
for migration and analysing tasks rather than for softwaneetbpment tasks.

The second Example should demonstrate an interactivegrogA simple guess-
ing game in WSL:

VAR <num =0, guess: =0>:
num : = @andon{ 100) ;
PRINT("l have thought of a number between 1 and 100");
DO PRI NFLUSH("Wat is your guess? ");
guess : = @tring_To Nun( @Read_Line(Standard_| nput_Port));
| F guess = num THEN PRINT("Correct!"); EXIT(1) FI;
| F guess < num
THEN PRI NT("Too |ow. ")
ELSE PRI NT("Too high.") FI QD
PRI NT(" Goodbye. ")
ENDVAR

The output should look something like this:

tenance Environme =lolx|
File Edt analyse window Help

B8 avsi =lolx| P =) =lglx
Wiew Edit  Wiew Transformation

|k

Execution time: 33297

Figure 5: Execution of the guessing game

A more in-depth reference of all possible WSL statementsbeaiound in p].
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3.2 Transformation Example

To demonstrate the transformation facility of FermaT weaddtice a small pro-
gram. The execution will just output “Hello World”. The reaxds encouraged to
save the following chunk of code in a file with a filename of Hisice.

VAR< x :=0, y:=0 >
DODOIF x = 0 THEN PRINT("Hel o World")
ELSIF x > (2 +x) - 1
THEN PRI NT(" Goodby cruel world")
ELSE EXIT(2) FI;
X = x + 1 0D OD ENDVAR

A click onto the firstDO statement should highlight the whole loop:

B Fermar Maintenance Environment - C: example.ws| .2 =0l xj
Fle Edt Analyse Window Help
= =101 x|| [ R =1olxflf =10/
View Edit Yiew Transformation
&l;l VAR < x i= 0, y i= 0 >: @@@
fovrmmam DODO IF x = 0
o st ;:ren s THEN PRINT("Hello World'} T0: Abort_Processing A
= ) Assigns ELSTE x > (2 + %) - 1 IT1: Absorh Left
= Assign THEH PRINT{'Goodby cruel world") \TZ: Absarb Right
. Varcialid FLSE EXTT(2) FI: T3 Actions to Where
7 & VIR T4: Add Assertion
i e 75: Ak Lt
- —-‘ASS"\;/" o Té: Align Nested Statements
: Ni:;h:féf) ¥ IT7: Bpply To Right
PP T6: Collapse Action System
o T Collapse All Action Systems
o T10: Combine Where Structures
) Statements IT11: Constant Propagations
T12: D Do Ta Floop
T13: Delste &l Assertions
T14; Delete &l Comments
T15: Delete Al Redundant
T16: Delete all Skips
T17: Delete Item
IT18: Delete Redundant Registers !ﬂ
Caret Position=25 | |+
B Con -0/ %
Tres Row=10

Figure 6: Transformation Example

We can test now for the available transformations on thisneith a click on the
“Test All Transformations” symbol in the transformatiortaague.

Test All Transformations

Test Single Transformation

Apply Transformation

Figure 7: Transformation Catalogue Toolbar
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Now some transformations should be highlighted in greeres&hransformations

can be applied on the current selected program item (Of emaose of them may
have no effect).

B rermat Maintenance Environment - C:iexample.wsl = =13l x|
Fle Edi Analyse Window Help

=] =10l x| [ =lolx| =l
Yiew Edit View Transformation
§|F=| VAR < x t= 0, ¥y =0 »: @J@@
) Statements bt i ol
i THEH PRINT("Hello World') t Propagation
g -+ ELSIF x > (2 + x} - 1
o THEN PRINT{"Goodby cruel world") T104: Delete Al Assertions
#® Var_Lvalue (x) ELSE EXIT(2) FI; \nmmgr\ts‘
& Number (0) PGS POV
2L ssion
® Var_Lvalue ()
® Humber (o)
= Statements
= o g
=) Statements J
& Qoo T114: Else IF To ElsF
R — T115: Elsf To Else IF
T116: Expand And Separate All
Caret Position=25 | "J
Hesese===l
Tree Row=10

Figure 8: Transformation Example

Now we select the transformation “Double to Single Loop”. Wk on “Apply
Transformation” should result in the following code:

VAR< x :=0, y:=0 >
DOIFx =0
THEN PRINT("Hel lo World")
ELSIF x > (2 +x) - 1
THEN PRI NT(" Goodby cruel world")
ELSE EXIT(1) FI;
X 1= x + 1 CD ENDVAR

The double loop has been eliminated and the exit statemsiaieinhe loop have
been decreased by one. After the transformation has bediedpipe attentive
reader may have recognised that the filename contains no®V.aEverytime the
source code is modiefied and saved the FME will generate arfilee{galled “in-
termediate version”). This includes the case when a tramsftion is applied. If
all modifications of the file have been finished the user magcsehe “Save (fi-
nal) WSL File and all intermediate versions of the file will theleted and the last
version will replace now the original file. The benefit of théshnique is that a
maintainer can access in the process of migration all psstirediate versions of
the processed program. If he did something wrong or appiedransformations
in a wrong order he can easily go back to an older version.

If the file is not saved than all modifications can be undow@ine with the “undo”
and “redo” options of the “Edit” menu entry.
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Through the “Simplify If” Transformation the program can sienplified to":

VAR<x :=0, y:=0>
DOIF x <> 0 THEN EXIT(1) FI;
PRINT("Hel lo World");

X 1= x + 1 0D ENDVAR

3.3 Working with the console

As mentioned before the FME is directly tied to the transfation engine. The
engine itself can be accessed via the console. The curregitaon and the current
item? is changed when a node in the FME’s Abstract Syntax Tree Wirfdis been
selected. To demonstrate this the reader may open a WSLapnogf his choice
and select a node in the tree. This node is now the currenintéme transformation

engine. If now the command

(@rint_WsL (@) "")

is entered in the Console the engine should output a subtrine AST with the
current item as the root.

B rermal Maintenance Environment - C:example-1.uwsl =101 >
File Edit Analyse Window Help

B M=

Yiew
L

) Skatements

=(@Print WSL (€I) "")
Assigns

Assign
Var Lvalue x
Hurber 0

d R=sigm
- fesion Var Lvalue y
& Yar_Lvalue () Hurber 0
& Mumber (0}
=1 Assign
& Var_Lvalue (y)
& Mumber {07

=i __) Statements
=1~ Floop
=i _) Statements
=k Cond
+_j Guarded
# ) Guarded

+1- ) Assignment

Tree Row=2 |(@Print_WSL (@™

Figure 9: Console to the transformation engine

1The interested readers may do this on their own.
2See P for details on these concepts
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For all possible commands please see the WSL mabjal [

3.4 Other functionalities of the FME

The FME includes some more functionalities for comfortakdage:

The graphical user interface of the FME consists of intewiatlows which may be
minimised, maximised or closed. The “Window” menu entryegivsome options
to automatically align these windows.

The “ActionSystem CallGraph” is a very useful feature whealgsing action sys-
tems.

T

File Edit Analyse ‘Window Help
& —laix] RETE [ lalx
Wiew Edit  Wiew Transformation
E‘EI VIR <m :=0, p := 0, last :=" " : X @@@
ratements ACTIONS PROG:
e PROG — T102: Canstant Propagation Al
= < line :=" ", m i=0, i := 1 >; CALL THHERE T103: D Da Ta Floop
ne B 5TRL visualisation Engine. =10l x|
L=i1i:=1+1; .
Diagram
IF i = n + 1 THEN CALL ALLDOHE FI:
m = 1;

E| & | Altituds: 161
IF last < item[i]

THEH IP write({line VAR os):
b 3
m o= 0;
CALL THHERE FI:
CALL MORE EHD

THHERE —

P = mmber[i]:
line := item[i]: FROG
line := line ++ " ' ++ p;

CALL MORE EHD
HORE —

Caret Position=>0

= INHERE
Tree Row=1 MORE

K|

Lol

Figure 10: ActionSystem CallGraph

The dialog can be activated within the “Analyse” menu entrgi WSL Action
System is present in the current program. It shows the qalisd action system
in a call graph. The user can automatically zoom-in ,hid&pse several nodes,
print the graphic and export the graphic to a vector/bitmigafdirmat.
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[web2] The Software Technology Research Laboratory (DefdariJniversity,
Leicester)
http://www.cse.dmu.ac.uk/STRL/index.html

[web3] Software Migration Ltd.
http://www.smltd.com

[web4]  Teach Yourself Scheme in Fixnum Days
http://www.ccs.neu.edu/home/dorai/t-y-scheme/tdyesae. html
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